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HDX2 System Overview 

HDX2 is the result of extensive development work by Trivinci LLC, whose goal was to release the “World’s First” 

Dual Stream 1080p High Definition (HD) Video Logger.  

This revolutionary system combines stunning 1080p HD video with extensive data capture capabilities in one 

easy‐to‐use video data package. Coupled with Race‐Keepers Comparo HD analysis software, HDX2 is the most 

powerful, competitively priced driver development tool available to help racers analyse and improve their driving.  

Trivinci LLC is one of the world’s most capable and trusted providers of video data loggers. We have been 

delivering video data systems to premier racing and driving experiences, racing series and programs for the past 

ten years across North America and Europe. 

 

HDX2 Hardware 

Each HDX2 system is supplied with the following components: 

• HDX2 Main System Unit 

• 1080p HD Bullet Camera(s) 

• 3m (10ft) Length Locking Camera Cable(s) 

• High Gain Microphone 

• 20Hz GPS Antenna 

• 12v Power Lead 

 

HDX2 can support a maximum of two (2) HD bullet cameras. These cameras can both be configured to capture at 

full 1080p HD video resolution (1920 x 1080 pixels) at 30 frames per second (fps) or they can be configured to 

capture at 720p HD video resolution (1280 x 720 pixels) at 60 fps. HDX2 automatically synchronises all video 

with high quality audio and any captured data at the point of recording. Standard data sources include 20Hz (20 

times per second) GPS and internal 3 axis accelerometers while additional available data sources include OBD-II, 

ECU/CAN and analog or digital sensors. HDX2 has built-in Wi-Fi capabilities so that it can communicate with 

Race-Keepers Predictive iDash Live Timing App (available for Apple and Android smartphones and tablets). 
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HDX2 Software 

There are three (3) types of software relevant to the HDX2 video data system: 

1. HDX2 Firmware – This is the software that controls how the Main System Unit functions. Generally HDX2 

Firmware is released in order to enable new features and functions in existing HDX2 systems. 

2. Race‐Keeper Comparo HD – This is PC based software for video data analysis and driver development. 

This software is also used to notify users of HDX2 Firmware and Race-Keeper Comparo HD updates that 

are available to download. 

3. Race‐Keeper Predictive iDash Live Timing App – This is an in‐car data display that offers predictive lap 

times based on GPS as well as displaying values for RPM, MPH, gear, and shift points 

HDX2 Firmware 

HDX2 Firmware controls system operation, system configuration, power management, auto‐stop and auto‐start 

management, video resolution and LED functions. HDX2 Firmware updates are available at no charge to HDX2 

owners and users. 

Comparo HD Analysis Suite 

Comparo HD is Race-Keepers video data analysis suite which plays synchronized video alongside course map and 

data traces, including speed, lap number, lap time, G forces, as well as any other data streams available via OBD-

II, ECU/CAN or from Analog/Digital sensors.  

One of Comparo HD’s most powerful features is “Compare Mode” which allows you to play back the video and 

data of two laps/outings side‐by‐side to analyse where/why/how time was lost or gained. 

Comparo HD is available at no charge to HDX2 owners and users. 
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Predictive iDash Live Timing App 

iDash is a free downloadable App, available for both Apple and Android devices in their respective App stores. 

When paired with HDX2’s WiFi output, iDash becomes an in‐car data display showing live race data including lap 

times, RPM, MPH, gear and shift points. iDash stores start and finish line positions for road courses, autocross, 

rally and hill climbs to provide accurate lap and stage information. 

   

Please refer to the Race‐Keeper iDash User Guide for installation and operating instructions: www.race‐

keeper.com/i‐Dash  

 

Wiring Schematic 
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• GPS – GPS Antenna Connector 

• HDMI Out – HDMI Connector for Live HD Output of Camera 1 Only 

• Camera 1 & 2 – USB3.0 Connector with camera cable thumbscrew retaining locks  

• Mic + AV Out – Quick Release Connector for Microphone and/or Composite Video Output 

Cable 

• USB – Quick Release Connector for OBD-II or other ancillary devices 

• USB/CAN – Quick Release Connector for OBD-II, CAN or other ancillary devices 

• Network – Quick Release Connector for Ethernet Output of Video and Data for Live 

Streaming 

• Power/CAN – Quick Release Connector for 12V Power and CAN 

• Record Button – Push to Manually Start/Stop Recording 

• Power Button – Push to Manually Power On/Off HDX2 

• Status LED’s – Visual Indication of HDX2 Operational Status 

• Memory Used LED’s – Visual Indication of Remaining Free Space on Memory Card/USB 

• USB Slot w/Cover – Remove Cover to Insert USB Memory Stick then Replace if Possible 

to Seal 

• SD Card Slot w/Cover – Remove Cover to Insert SD Card then Replace to Seal 



 

 

  

 

Trivinci LLC  HDX2 User Guide v1.0.1 October 2015 13 

   

 

Installing HDX2 

Quick Release Connectors 

HDX2 utilises rugged, locking Hirose connectors for all connectors, with exception of the GPS antenna, HDMI 

output and camera connectors. All connectors are pattern‐keyed to ensure that all cables can attach only to the 

intended connector on the Race‐Keeper system. 

To attach a connector, hold it with the white arrow pointing upwards then push connector on to the HDX2 video 

data system. The connector has been successfully attached and locked when the connector “clicks” into place. 

 

To detach a connector, pull back on the black ring with the white arrow to release the connector lock. 

‐‐‐‐>DO NOT twist the connector body! 

 

Installation Steps 

To successfully install a HDX2 video data system in your vehicle, please follow these simple instructions: 

1. Install Camera(s) 

Camera 1: Via the use of a Roll Bar Mount (optional extra), Aero Bodywork Mount (optional extra), 

Windscreen Mount (optional extra) or via any other solid mounting solution, install Camera 1 so that it is 

as close to the windscreen as possible, with the camera pointing forwards so that both sides of the 

vehicles bonnet or the front wheels are visible. Ideally you should aim to have between 30-40% of the 

cars bodywork in the camera frame as this will help stabilise the cameras auto-light adjustment and 

improve overall video quality. 

 

Camera 2: Install Camera 2 behind the driver so that it is aimed over their shoulder to review driver 

activity. If placed inside a roofed vehicle the camera will auto adjust to darker conditions providing better 

visual clarity of the driver’s activity however this will mean that anything outside of the cockpit may be 

over-exposed. If you decide to use this as a rear facing camera, please refer to the guidance offered for 

the placement of Camera 1. 
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Fine Tuning Camera Installation: HDX2 Cameras have an arrow on the top to help you identify the correct 

orientation. Its USB3.0 connector can also be a useful guide as it is positioned horizontal and slightly 

above centre. Use an alcohol wipe to clean the camera lens cover of fingerprints when finished. 

 

2. Check Cable Lengths 

Once you have identified the “ideal” locations for the cameras, it is advisable to connect the locking 

camera cables to the back of the cameras and ensure there is sufficient length to reach the desired box 

location. If this is not possible, you will need to relocate one or 

other components. You may also wish to consider the other 

cables when checking everything will reach. 

 

PLEASE NOTE: The two ends of the Locking Camera Cables 

are NOT the same. The rubber flange on one end perfectly 

locks and seals with the HDX2 bullet camera and the other 

perfectly locks and seals with the Main System Unit. 

 

3. Install 12v Power Cable 

All HDX2 power cables are supplied with built-in fuses for system safety.  

 

Unterminated Power Cable: With the unterminated power cable, either connect the RED (12v) and BLACK 

(GND) wires direct to your battery or connect to your isolator switch assembly so that the HDX2 system is 

powered when the electrics are switched on. 

 

Cigarette Adaptor Power Cable: If you are using HDX2 in a road legal car, it is likely you will have access to 

a cigarette lighter adaptor into which the Cigarette Lighter Adaptor Cable can be connected for 12v 

 

Separate 12v Battery: Powering HDX2 via a secondary 12v battery is fine. The system draws about 1.4A 

at 12v with two cameras connected so depending on the duration and regularity of your events, you will 

need to ensure you utilise a battery of sufficient capacity.  

 

4. Install Microphone 

Install the Microphone in an area sheltered from excessive wind noise, as close to the drivers head as 

possible. It is advisable that the microphone cable be positioned away from any high voltage cables to 

avoid electrical interference. 

 

5. Install GPS Antenna 

Position the GPS Antenna so that it is horizontal, in the centre of the vehicle and has a clear view of sky. 

HDX2 GPS Antennas have a magnetic base which makes installing on metal car roofs easy. 
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6. Install HDX2 Main System Unit 

Install the HDX2 Main System Unit into your vehicle using either the system mounting tray (optional 

extra) or strong Velcro, possibly combined with tie wraps, to securely hold it in place. Ideally you should 

position the main box as central as possible, horizontal and with the electrical connectors pointing 

forwards. This will improve the accuracy of the Internal Accelerometers. 

 

7. Power Up System 

After all other cables are connected, you should then connect the power lead. The box should 

automatically power on and start to boot. During the booting sequence you will see the “Memory Used” 

LED’s cycle backwards and forwards for about 45 seconds until eventually you will have a flashing red 

LED in “Memory Used 100%”, a flashing blue LED in “GPS” and a solid green LED in “Power”. Once you 

insert a USB or SD Card, the flashing red LED in “Memory Used 100%” will be replaced by a solid green 

LED in “Status” (More information on Status LED sequences can be found on page 15) 

 

8. Live HDMI Output 

In order to check camera positions/angles, you can connect a TV, screen or computer via HDMI cable to 

the HDMI OUT socket to view Camera 1 live. In order to check Camera 2, you will need to plug this camera 

into Camera port 1 and wait 45 seconds for the camera to boot up. 

 

PLEASE NOTE: Most HDMI ports on laptops are HDMI OUT only and so cannot be used to view the live 

output of HDX2. 

 

9. Sample Recording 

If you are unable to view the cameras live via the HDMI OUT socket, you can make a sample recording to a 

USB or SD card and use this to modify your camera positions/angles. 

 

Press the RECORD button to manually start recording: This should result in a solid red LED in “Record” 

and an audible beep. Record for your desired duration of time. 

 

Press the RECORD button again to manually stop recording: This should result in a flashing red LED in 

“Record” and an audible beep. When the flashing red LED goes out, you are able to remove the USB or SD 

card. 

 

Insert USB or SD into your computer - Open the newly created folder whose title will be a long string of 

numbers (e.g. 10132_20150516_1423) and double click on the “video.mp4” file. This should open the 

video in your default media player and allow you to see both cameras. If you only see one camera, your 

media player cannot decode multiplexed video. This is not a major issue as most files will be played back 

in Race-Keepers Comparo HD software but if you wish to view both cameras in this way, we would 

recommend downloading the VLC media player - http://www.videolan.org/vlc/index.en_GB.html  

 



 

 

  

 

Trivinci LLC  HDX2 User Guide v1.0.1 October 2015 16 

   

 

Zero‐‐‐‐ing the Accelerometer 

After system installation, it is advised that you zero the accelerometer on the HDX2 system to ensure maximum 

accuracy of the G force values. In order to zero the accelerometer you will first need to download the file named 

ZERO-ACCEL from our website downloads page: http://www.race-keeper.com/downloads/index.php 

1. Copy the file from the link above ("trivinci.id") to a blank SD card or USB stick. 

2. Park vehicle on level ground. 

3. Power on your HDX2 system and wait until the system is has fully booted (finished cycling LED’s). 

4. Insert SD or USB with the zero accel file into the Race‐Keeper system. 

5. The orange “Transfer” LED will start to flash. 

6. Remove the SD or USB after 10 seconds. Don’t worry if the orange “Transfer” LED is still flashing and 

continues to do so, that is perfectly normal. 

7. Reboot your HDX2 system. 

8. Delete trivinci.id file from SD or USB before attempting to record a video data session to that media. 

 

Calibrating the Accelerometer Orientation 

After system installation, in addition to zero‐ing the accelerometer on the HDX2 system, we recommend 

calibrating the accelerometer orientation for correct display of inline and lateral G’s on the accelerometer gauge in 

Comparo HD, however this can also be done as a post-process once a recording has been made. 

Please see “How to Set the Accelerometer Gauge Orientation” on page 32 for more information on calibrating the 

accelerometer using Comparo HD software. 

 

LED Messages 

The LED’s on the HDX2 Main System Unit can be used to determine the status of the system. All the LED 

messages are shown below with the exception of the “LED cycling” effect that occurs when the system first 

boots. You may also see different LED behaviour when you update the HDX2 firmware.  

LED Label Solid Flashing Off 
Status Green = Ready to Record  Not Ready to Record 

Transfer Yellow = Updating System  Yellow = Zero-ing Accelerometers Update Complete 

Power Red = System Powered Off 

Green = System Powered On 

 No Power 

GPS Blue = Satellites Found Blue = Searching for Satellites No GPS 

Recording Red = Recording Red = Writing Video File to USB/SD Not Recording 

Memory 100% Red = USB/SD Full 

Yellow = USB/SD 80% Full 

Red = No USB/SD Card Inserted >20% USB/SD Remaining 

Memory 75% Green = USB/SD 75% Full  >25% USB/SD Remaining 

Memory 50% Green = USB/SD 50% Full  >50% USB/SD Remaining 

Memory 25% Green = USB/SD 25% Full  >75% USB/SD Remaining 
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Configuring Your HDX2 System 

PLEASE NOTE: The following steps are taken within the Comparo HD 

software suite. If you have not yet installed this software, please skip 

to page 26 for advice on this before returning to this section. 

Via the Comparo HD software you can configure your HDX2 system 

to automatically power on, and to automatically start and stop 

recording via the use of speed and time triggers. You can also change 

your video quality settings and camera layout. Configuring your Race‐

Keeper system is a two‐step process: 

1. First you choose your desired configuration and save the 

resultant update file to a USB/SD. 

2. Next you insert this USB/SD into the HDX2 system and 

power it up. 

 

Create configuration and save to SD/USB 

• Open Comparo HD and select Configure‐>Configure Race‐Keeper Hardware from the dropdown menu. 

• Ensure “Race-Keeper HDX2” is selected as your system model and then modify your configuration 

accordingly. 

• When you have finished making changes to the way your HDX2 system operates, click Save. 

• Insert a blank USB/SD, select the USB/SD as the desired save location and click OK to save the 

configuration file to the USB/SD. 

• On the USB/SD should now be a file called “capture.cfg” 

• If you ever wish to return your HDX2 system to its factory settings, just click on the “Defaults” button and 

then save this configuration to a USB/SD card. 

 

Upload configuration to system 

• Power on your HDX2 system and wait until the system is ready. 

• Insert USB/SD. 

• The orange “Transfer” LED will illuminate briefly. 

• The HDX2 system will reboot (typical duration of 45 seconds) 

• You should delete the “capture.cfg” file from the USB/SD before attempting to record a video data 

session to that media. 
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Recording Video Data Outings 

There are many ways to initiate video data recording: 

• HDX2 can be configured to boot automatically when power is connected. This function is enabled via the 

Race‐Keeper Comparo‐>Configure->Configure Race-Keeper Hardware menu 

• HDX2 can be configured to record automatically upon insertion of USB or SD Card. This function is 

enabled via the Race‐Keeper Comparo‐>Configure->Configure Race-Keeper Hardware menu 

• You can push the record button on the HDX2 Master System Unit to start the recording 

• HDX2 can be configured to auto‐record when the vehicle exceeds a configurable speed. This function is 

enabled via the Race‐Keeper Comparo‐>Configure->Configure Race-Keeper Hardware menu 

There are also a few ways to stop video data recording: 

• You can push record button on the HDX2 Main System Unit to stop the recording. You must wait until the 

red “Recording” LED stops flashing before removing USB or SD 

• HDX2 can be configured to auto‐stop recording when the vehicle slows below a user configurable speed 

for more than N seconds, where N = number of seconds as defined by the user. This function is enabled 

via the Race‐Keeper Comparo‐>Configure->Configure Race-Keeper Hardware menu 

 

Session Folder Names and Files 

Race‐Keeper automatically creates a folder for each recorded session. Race‐Keeper automatically names the 

folder according to the following convention #####_YYYYMMDD_HHMMSS, where: 

• ##### = HDX2 Main System Unit serial number 

• YYYYMMDD = Date of session 

• HHMMSS = Time of session (GMT) 

Note: If you use Import (see Importing and Opening Track Outings), Comparo HD will append the above 

nomenclature with the text that is entered in the Session Name field. An example: 

When importing you use the Session Name “Run 7 – New Tyres” which was captured on 30th March 2015 at 

14:37:35(GMT) by HDX2 serial number 10001. Therefore the session folder created will be named: 

“Run 7 – New Tyres 10001_20150330_143735” 

Inside these folders you will find two files: 

• outing.rkd: This encapsulates data and synchronization files, 

• video.mp4: This is the container for the multiplexed video files 

Race‐Keeper produces video and data files independently, which gives maximum flexibility to configuring gauge 

overlays and composing exported video files. 
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Updating Your HDX2 Firmware 

We deliver all HDX2 systems with the latest firmware installed at the time of shipment. We occasionally issue 

updates to HDX2 firmware to add new features, enhance existing features, and fix bugs. 

We notify all customers who have registered on http://www.race-keeper.com via email when updates are 

available for HDX2 firmware. 

The process to update HDX2 firmware is very similar to that which is used to change the system configuration: 

1. Visit http://www.race-keeper.com/downloads/index.php and download the latest HDX2 firmware 

2. Copy the software update to SD. Do not try to perform HDX2 firmware updates via USB 

3. Power on your HDX2 system and wait until the system has fully booted (typically 45 seconds). 

4. Insert SD into the HDX2 system. 

FROM THIS STAGE ONWARDS DO NOT REMOVE OR INTERRUPT POWER DURING THE SYSTEM SOFTWARE 

UPDATE PROCESS. 

5. The orange “Transfer” LED will illuminate solid for up to several minutes. 

6. The system should automatically reboot and continue the update sequence. 

7. The HDX2 firmware update may require the system to update and restart twice. 

8. If the system has been unresponsive for five (5) minutes, reboot your HDX2 system manually and permit 

the system to continue updating. 

9. Before removing the SD card that you used to update your system, push the record button to confirm 

that the system records and operates normally. 

10.  Remove the SD card you used to update your system and insert it into a PC to check whether: 

a. The HDX2 firmware files still appear – If successful, the system should have deleted all of the 

update files it used. 

b. The test recording is present and plays back OK 

11. If HDX2 firmware still remains on the SD card, the update was not successful.  

 

HDX2 Cameras 

All HDX2 systems are supplied with either one (1) or two (2) compatible 1080p HD bullet cameras. These cameras 

have an 80° viewing angle and, once a locking camera cable has been 

attached, are fully waterproof and therefore perfect for use in open cockpit 

vehicles or mounting externally (i.e. Roof, Bonnet, Sidepod). 
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On both the top and the bottom of the HDX2 bullet camera body are standard 1/4-20 mounting holes (1/4” w/20 

threads per inch) which can be used to attach a number of aftersales camera mounts. Race-Keeper can supply a 

number of different camera mounting solutions available. Please go to “Camera Mounts” on page 24 for more 

details. 

HDX2 bullet cameras have a removable front section which holds the lens cover in place as well as the rubber 

gaskets, which help to seal the lens cover and protect the camera lens from damage, moisture and dirt ingress. If 

this lens cover becomes damaged, they can be replaced. If one (1) camera is mounted inside a closed cockpit 

while another is mounted externally, you may choose to remove the lens cover from the internal camera so that 

you have a spare for the external camera. The cameras do not require the lens covers to be in place to operate, 

only to protect the camera from moisture and dirt ingress. 

All HDX2 bullet cameras are tested and focused prior to shipment. The cameras will not require focusing unless 

the lens is replaced or otherwise disturbed. 

Locking Camera Cables 

Alongside each HDX2 bullet camera you will find a 3m (10ft) length Locking 

Camera Cable which has USB3.0 connectors at each end, with a rubber 

sealing flange and thumbscrews.   

PLEASE NOTE: The two ends of the Locking Camera Cables are not the same. 

The rubber flange on one end perfectly locks and seals with the HDX2 bullet 

camera and the other perfectly locks and seals with the Main System Unit. 

 

Replacing Lens Cover 

The lens cover protects the HDX2 bullet camera lens from damage due to stones, dust and moisture. If the bullet 

camera is mounted on the outside of the vehicle, the lens cover should be wiped clean after every track session, 

and potentially replaced after each race weekend to ensure the camera image is always crisp and clear. 

To replace the lens cover: 

• Unscrew the front section of the HDX2 bullet camera that holds the lens cover (lens cover holder). 

• Remove the inner metal spacer ring, the two (2) black ‘O’ rings and the old lens cover from the lens cover 

holder. 

• Clean the end of the lens cover holder and all of the ‘O’ rings you plan to reuse to remove dirt. 

• Drop one (1) black ‘O’ ring into the lens cover holder and ensure it is seated properly at the end. 

• Holding by its edges, drop in the new lens cover, being careful not to touch the lens cover surfaces. 

Ensure the lens cover is seated properly at the end. 

• Drop in the second black ‘O’ ring and ensure it is seated up against the new lens cover properly. 

• Drop in the metal spacer – this compresses the two (2) ‘O’ rings to hold the lens cover in place. 
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• Screw the lens cover holder back onto the HDX2 bullet camera – tighten all the way being sure not to 

damage the ‘O’ ring that sits on the HDX2 camera body at the back of the threaded section 

• Once the new lens cover is in place, spray with moisture repellent (e.g., Rain‐X) to ensure water does not 

obscure the video image when driving in wet conditions. 

 

HDX2 Microphones 

Standard Microphone 

The standard HDX2 microphone is extremely durable and can pick up an exceptional range of audio, including 

conversation and engine noise. The HDX2 Main System Unit uses Automatic Gain Control that adjusts audio 

levels automatically to maintain a constant sound level. You also have the ability to adjust the playback volume 

level in the Comparo HD software. 

To install the microphone, place it away from direct wind noise if possible. If you're recording in an open cockpit 

(e.g., in a single‐seater race car or in an open top sports car), consider adding a wind cover to dampen irritating 

high‐frequency wind interference. 

Microphone with Auxiliary Input 

Within certain motorsport pursuits, you may wish to have a physical connection to the radio communication 

system as well as, or instead of capturing ambient cockpit noise. This is most common in rallying where you wish 

to hear the co-drivers pace notes on video playback during stage recces. 

HDX2 supports two (2) channel audio input devices and you are able to purchase an HDX2 microphone that has a 

secondary Female Jack Socket which can be connected to the radio communication system.  

Both the ambient cockpit noise and radio communication will then be captured however you will not be able to 

playback both audio channels together. You can only playback one (1) at a time via the Comparo HD dropdown 

menu “Configure->Audio Track”. 

 

HDX2 Data Sources 

HDX2 can support a number of different data sources, all covering the range of driver inputs (brake, throttle, 

steering) and vehicle inputs (speed, RPM, temps, pressures). 

The four major types of data sources which are supported and automatically displayed in Comparo HD are: 

• Standard data 

• OBD‐II data 

• ECU data 

• Sensor data

All data sources are logged at 30Hz (30 times per second). Data streams from all sources are synced 

automatically with captured video. 



 

 

  

 

Trivinci LLC  HDX2 User Guide v1.0.1 October 2015 22 

   

 

Standard Data 

Every HDX2 system delivers the following data, most of which are essential for driver development: 

• Speed 

• Lap number 

• Lap time 

• Split time 

• Lateral, vertical and 

inline G force 

• Voltage 

HDX2 acquires speed from its 20Hz GPS antenna, which also enables lap number, lap times, split times, and 

display of course map with user‐configurable split markers. The G force data is acquired from the tri-axial on‐

board accelerometer inside the HDX2 Main System Unit. For optimal G force data, install the HDX2 Main System 

Unit with connectors facing forwards and after installation, zero the accelerometer. 

 

OBD‐‐‐‐II Data 

To acquire additional data from road cars, HDX2 acquires data from OBD‐II (On‐board Diagnostic). All cars built 

since January 1, 1996 are equipped with OBD‐II. Depending on the make/model, OBD‐II data delivers up to the 

following ten (10) additional data channels: 

• Vehicle speed 

• Engine RPM 

• Throttle position 

• Engine coolant 

temperature 

• Fuel pressure 

• Intake air temperature 

• Intake manifold 

pressure (manifold 

absolute pressure 

(MAP)) 

• Mass air flow (MAF) 

• Fuel level input 

• Calculated engine load 

value 

 

Configuring Your HDX2 System for OBD‐II 

There is NO configuration required. Physically connecting the OBD-II 

Adaptor automatically stimulates the system to acquire OBD‐II data. 

Comparo HD also automatically displays the additional OBD‐II data 

alongside standard data traces. 

 

Connecting OBD‐II to Your Race‐Keeper System 

To create a connection between your vehicles OBD‐II port and your HDX2 system: 

• Connect the supplied HDX2 OBD‐II Adaptor to the OBD-II port on your vehicle. OBD‐II ports are typically 

located on the driver side above the pedals, under the steering column. 

• Connect the USB that exits the OBD-II Adaptor to the HDX2 USB A (F) to Quick Release Connector Cable. 

• Connect the other end of the HDX2 USB A (F) to Quick Release Connector Cable to the “USB” connector on 

the HDX2 Main System Unit 
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Acquiring OBD‐II Data from Your Vehicle’s OBD‐II 

To acquire ODB‐II data: 

• Power on your vehicle (i.e., turn key to Ignition). 

• Depending on OBD‐II Adaptor model, the OBD-II Adaptors red Status LED should turn on, indicating that 

the OBD‐II Adaptor is properly connected and powered by 12v from the vehicle. 

• The OBD-II Adaptors Status LED should now turn green, which indicates that the OBD‐II Adaptor is 

properly connected to the HDX2 system. 

• The Tx (transmit) and Rx (receive) LEDs will flash as OBD‐II data is transmitted from the vehicle to the 

HDX2 system (i.e. HDX2 requests each OBD‐II data channel from the vehicle’s ECU; the ECU responds 

with data value). 

 

ECU Data 

To acquire data from vehicles with race or aftermarket ECUs, Race‐Keeper connects to CAN (Controller Area 

Network) or serial data stream output from the ECU. Depending on the make/model, ECU data delivers many 

additional data channels, including: 

• Speed 

• RPM 

• Throttle 

• Steering angle 

• Gear 

• Water temp 

• Oil temp 

• Intake air temp 

• Fuel pressure 

• Oil pressure 

• Exhaust temp 

• Brake pressure (rear) 

• Brake pressure (front) 

• Vehicle yaw rate 

For more information on ECU data, including configuring your HDX2 system to acquire ECU data, please refer to 

the separate “ECU/CAN user guide”. 

 

Sensor Data 

To acquire data from vehicles that do not have OBD‐II or ECUs, HDX2 acquires data from analog or digital sensors 

via an optional Analog to CAN Convertor Module. For more information on using an Analog to CAN Convertor 

Module please view the separate “Analog to CAN Convertor Module user guide”. 
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Data Sources Quick Reference 

Data Source Comparo HD Label 
Speed (GPS) Standard Speed (GPS 

Lap Number(s) Standard Lap # 

Lap Time(s) Standard Lap 

Lateral G Standard Lateral G 

Vertical G Standard Vertical G 

Inline G Standard Inline G 

Voltage Standard Voltage 

Vehicle Speed OBD-II Speed (OBD-II) 

Engine RPM OBD-II RPM (OBD-II) 

Throttle Position OBD-II Throttle (OBD-II) 

Engine Coolant Temperature OBD-II Coolant Temp (OBD-II) 

Fuel Pressure OBD-II Fuel Pressure (OBD-II) 

Intake Air Pressure OBD-II Intake Air Temp (OBD-II) 

MAP (Intake Manifold Absolute Pressure) OBD-II MAP (OBD-II) 

MAF (Mass Air Flow) OBD-II MAF (OBD-II) 

Fuel Level Input OBD-II Fuel Level (OBD-II) 

Calculated Engine Load Value OBD-II Engine Load Calc (OBD-II) 

RPM (Digital Sensor or Tach) Analog to CAN Adaptor Module RPM (Tach) 

Steering (Analog Sensor) Analog to CAN Adaptor Module Steering (Sensor) 

Throttle (Analog Sensor) Analog to CAN Adaptor Module Throttle (Sensor) 

Brake (Analog Sensor) Analog to CAN Adaptor Module Brake (Sensor) 

Speed ECU/CAN Speed (ECU) 

RPM ECU/CAN RPM (ECU) 

Throttle ECU/CAN Throttle (ECU) 

Steering Angle ECU/CAN Steering Angle (ECU) 

Gear ECU/CAN Gear (ECU) 

Water Temperature ECU/CAN Water Temp (ECU) 

Oil Temperature ECU/CAN Oil Temp (ECU) 

Intake Air Temperature ECU/CAN Intake Air Temp (ECU) 

Fuel Pressure ECU/CAN Fuel Pressure (ECU) 

Oil Pressure ECU/CAN Oil Pressure (ECU) 

Exhaust Temperature ECU/CAN Exhaust Temp (ECU) 

Brake Pressure (Rear) ECU/CAN Brake Pressure-Rear (ECU) 

Brake Pressure (Front) ECU/CAN Brake Pressure-Front (ECU) 

Vehicle Yaw Rate ECU/CAN Vehicle Yaw Rate (ECU) 
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Optional HDX2 Add-ons 

Alongside the main hardware components that are required to successfully operate a HDX2 system, Race-Keeper 

supply a number of optional add-ons which simplify or expand the HDX2 experience: 

Mounting Tray 

The HDX2 Mounting Tray has been designed to the HDX2 Main System Unit 

via a slot and screw method. It is also supplied with four (4) anti vibration 

mounts which will help isolate the HDX2 Main System Unit from excessive 

vibration. 

Camera Mounts 

Race-Keeper offer a wide range of camera mounting solutions:  

Roll Cage Mounts (Metric) 

These machined aluminium brackets are designed specifically to mount 

the HDX2 bullet cameras solidly in a vehicle that contains a roll cage. The 

roll cage clamp section is in two parts and is profiled to suit bar diameters 

from 35mm to 45mm. It is tightly clamped in place using two (2) M4 hex 

bolts. The camera section is hinged to aid with minor camera position 

adjustments during initial installation. When positioned correctly, the two 

(2) M4 hex bolts both solidly clamp the HDX2 bullet camera into the 

mount and restricts rotational movement of the mount. 

PLEASE NOTE: You will need to apply a small amount of tape to both the roll bar and camera, both as a means to 

protect the coating, but also to ensure all parts clamp together firmly. 

Roll Cage Mounts (Imperial) 

An alternative option for mounting on to roll cages would be to use roll hoop collar 

clamps, which are available in the following sizes: 1 & 3/8”, 1 & ½”, 1 & 5/8”, 1 & ¾”, 

and 1 & 7/8”. 

Aero Bodywork Mounts 

A lot of HDX2 users mount the forward facing camera on the roof of their car, as this can 

provide a better view of your track position. Race-Keeper can supply a HDX2 bullet camera 

specific, aero-profiled mount for this, which would be attached to the vehicle body via 

some 3M VHB double-sided adhesive tape. Be sure to clean and degrease the surface to 

achieve maximum adhesion. 
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Windscreen Mounts 

Race-Keeper can supply some heavy duty windscreen mounting solutions. If you decide to 

purchase your own aftermarket windscreen mount, please be sure that it can securely hold 

the HDX2 bullet camera in position.  

Twin Camera Mounts 

In some applications, you may need to mount two (2) HDX2 bullet cameras together, or you 

may wish to use this mounting solution to hold one (1) camera. The mount is attached to a 

flat surface via some 3M VHB double-sided adhesive tape. Be sure to clean and degrease 

the surface to achieve maximum adhesion.  

 

Microphone with Auxiliary Input 

As previous mentioned, some race and/or rally drivers may need to capture both the ambient cockpit noise as 

well as audio from the radio communications system. The HDX2 Microphone with Auxiliary Input allows you to 

achieve this. 

 

Microphone Wind Cover 

If your microphone is going to be positioned where wind could be a problem, consider purchasing an HDX2 

Microphone Wind Cover in order to dampen out the annoying high frequency whistling noises. 

 

Power Cables 

There are three (3) different HDX2 Power Cables available: 

• 3m (10ft) Unterminated Fused Power Lead 

• 3m (10ft) Cigarette Lighter Adaptor Power Lead 

• 3m (10ft) Unterminated Fused Power Lead with CAN  

 

ECU/CAN Cables 

The HDX2 Main System Unit supports two physical ECU/CAN connections: 

1. On the Power/CAN Connector 

2. On the USB/CAN Connector 

You may wish to upgrade your existing HDX2 Power Cable to one that supports CAN and connect this to the 

Power/CAN Connector or you can purchase a standalone CAN Cable and connect this to the USB/CAN Connector. 
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OBD-II Adaptor 

The OBD-II Adaptor has previously been discussed at length. Please see the “HDX2 Data Sources” section on 

page 20 for more details.  

Analog to CAN Convertor Module 

Live Output HDMI Monitor 

Remote Record Switch & LED 

 

Comparo HD 

Comparo HD is Race-Keepers video data analysis suite which plays 

synchronized video alongside course map and data traces, including speed, lap 

number, lap time, G forces, as well as any other data streams available via 

OBD-II, ECU/CAN or from Analog/Digital sensors.  

One of Comparo HD’s most powerful features is “Compare Mode” which allows you to play back the video and 

data of two laps/outings side‐by‐side to analyse where/why/how time was lost or gained. 

Comparo HD is available at no charge to HDX2 owners and users. 

 

Installing Comparo HD Software 

Comparo HD works in tandem with HDX2 on‐board systems, which captures and automatically synchronizes 

High Definition (HD) video and data. With Comparo HD, you can quickly identify how to improve your driving and 

decrease your lap times. 

To install Comparo HD: 

• Download Comparo HD from the Race-Keeper website http://www.race-

keeper.com/downloads/index.php and launch the installation. 

• Follow the simple installation instructions and then click Finish to automatically start Comparo HD. 

 

Updating Comparo HD 

Any new versions of Comparo HD will be listed on our website at http://www.race-

keeper.com/downloads/index.php, however we will directly email all customers who have registered on the 

website to notify them when a new version is available. 
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Menus and Main View 

After you’ve opened Comparo HD, you’ll notice that there are five dropdown menus across the top of the screen 

and a button that is labelled “Open”.  

 

The dropdown menus are as follows: 

• File: This menu contains opening, closing, importing and exporting controls/features 

• Compare: This menu is for comparing laps and outings 

• Configure: In this menu you will configure how Comparo HD functions and create configuration update 

files for your HDX2 Main System Unit. 

• View: This menu enables you to switch between the standard and expanded views 

• Help: This menu contains links to instructional videos, shortcut keys, software/firmware updates  

 

Configuring HDX2 

Within the Comparo HD software you can configure your HDX2 system to 

automatically power on, and to automatically start and stop recording via the 

use of speed and time triggers. You can also change your video quality 

settings and camera layout. Configuring your Race‐Keeper system is a two‐

step process: 

1. First you choose your desired configuration and save the resultant 

update file to a USB/SD. 

2. Next you insert this USB/SD into the HDX2 system and power it up. 

 

Create configuration and save to SD/USB 

• Open Comparo HD and select Configure‐>Configure Race‐Keeper Hardware from the dropdown menu. 
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• Ensure “Race-Keeper HDX2” is selected as your system model and then modify your configuration 

accordingly. 

• When you have finished making changes to the way your HDX2 system operates, click Save. 

• Insert a blank USB/SD, select the USB/SD as the desired save location and click OK to save the 

configuration file to the USB/SD. 

• On the USB/SD should now be a file called “capture.cfg” 

• If you ever wish to return your HDX2 system to its factory settings, just click on the “Defaults” button and 

then save this configuration to a USB/SD card. 

Upload configuration to system 

• Power on your HDX2 system and wait until the system is ready. 

• Insert USB/SD. 

• The orange “Transfer” LED will illuminate briefly. 

• The HDX2 system will reboot (typical duration of 45 seconds) 

• You should delete the “capture.cfg” file from the USB/SD before attempting to record a video data 

session to that media. 

 

Comparo HD Shortcut Keys 

Race‐Keeper provides a number of helpful shortcut keys. You should have received a “Comparo HD Keyboard 

Shortcuts” sticker with your HDX2 but if not, you can learn all of the keyboard shortcuts from within the Comparo 

HD software: 

How to View All Shortcut Keys 

To view a complete list of shortcut keys: 

• Select Help‐>Keyboard Shortcuts 

The keyboard shortcut is the key indicated to the left of the 

command i.e.  

• To open a new outing, press “o” on the keyboard 

• To move the video forward one (1) frame, press the 

right arrow on the keyboard. 
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Importing and Opening Track Outings 

How to Import an HDX2 Track Outing into Comparo HD 

To import a recording into Comparo HD: 

• Open Comparo HDZ  

• Insert USB/SD with the recordings 

Comparo HD should recognise that you have inserted a 

USB/SD and search it for recordings. If this does not 

automatically occur or if the USB/SD was inserted before 

Comparo HD was open, just go to: 

• File->Import Outings from USB or SD 

• If more than one media is inserted, select the drive letter from which to import recordings 

Once the Export window is open and some recordings have been found, you can preview the video, add session 

name (i.e. Stage 2 – New Tyres), session type (ie. Rally), driver and car info to individual sessions. You can also 

add/edit details later. 

You can hold CTRL and select multiple outings to import 

You may choose to change the folder into which imported recordings are saved. You would do this by clicking on 

the “Importing to” button and by selecting/creating a different folder depending on how you wish to organise 

your recordings. 

PLEASE NOTE: In the bottom left corner of the Import screen is a checkbox asking if you wish to delete recordings 

from the USB/SD after they have been imported. Check this box if you want Comparo HD to delete the files from 

your USB/SD. If you would prefer to do this manually, leave it unchecked. 

After you have completed all of the above steps, click Import. 

Once a recording has been imported, it will appear in the Comparo HD library of outings in the Open window (see 

next section). 

 

How to Open an HDX2 Track Session 

To open an HDX2 session: 

• Use Import (see above) or copy file(s) from your USB/SD to a folder on your PC. 

• If you copy files from a USB/SD directly to a folder on your PC (i.e., you don’t use Import), you will need to 

point Comparo HD to the folder(s) in which your recording folders reside using the Scan feature. 

• Click the Open button in Comparo HD and then select Scan in the bottom left corner 
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• Browse for the folder on your computer that contains your recordings and then click OK. All sessions 

within the target folder are scanned and added to the Comparo HD library in the Open window; new 

sessions are added to the bottom of the list unless you re-order the library based on GPS Data/Time, 

then they would appear at the top. 

• Click on an HDX2 track session in the Comparo HD library and then click Open. 

PLEASE NOTE: You can open and play session(s) directly from USB/SD but we strongly recommend copying 

sessions to your PC for optimal playback. 

Four Main Areas of a Track Outing 

The main Comparo HD view layout is comprised of four (4) 

different and distinct sections: 

• Video, which plays dual stream HD video side by side 

• Data, which displays data traces  

• Course map, which shows the GPS derived track map 

• Session info, which shows lap info and splits 

 

Video 

To enter the Default Video player screen in Comparo HD press the “V” keyboard key: 

• Video/Audio playback control – Play, Pause, Volume 

• Lap number/time information 

• GPS date and time information 

• Video navigation controls – Inter-lap and intra-lap navigation sliders 
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If you double-click on one (1) of the dual video streams, then you enter Fullscreen Mode. 

 

In Fullscreen Mode, the camera layout becomes picture-in-picture. You are able to easily switch which camera is 

the main image by double clicking on the smaller picture-in-picture image. 

The video/audio playback and navigation controls remain although you do not have the intra-lap navigation 

control bar. 

You will also notice that some additional graphical displays appear in Fullscreen Mode such as the course map 

overlay shown in the above image. These are enabled/disabled from within the Gauge Manager screen.  

 

How to Add, Move and/or Remove Gauges 

Comparo HD displays animated gauge overlays that 

can be added or removed from the Default Video 

player screen and/or Fullscreen Mode. HDX2 

creates video and data files independently, 

providing maximum flexibility to configuring gauge 

overlays and exported video files. 

To add or remove a Gauge: 

• Select Configure‐>Gauge Manager 

• Click the ON/OFF button to enable/disable 

gauges 

• Click on pull‐down menus to select a 

different gauge design 

• Click on to close Gauge Manager 
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To add or remove Data Overlays from Fullscreen Mode: 

• Check/Uncheck the boxes in the section titled “Fullscreen Data Overlays” 

To move a Gauge or Data Overlay on the video: 

• Left-click on the gauge, hold down the mouse button and move the gauge 

To resize a Gauge or Data Overlay on the video: 

• Hold down the SHIFT key then left-click on the gauge, hold down the mouse button and move up/down 

to resize 

How to Set the Accelerometer Gauge Orientation 

After you’ve installed your HDX2 system, we recommend setting the accelerometer gauge orientation in 

Comparo HD: 

• Select Configure‐>Gauge Manager 

• Left click on the red arrow in the accelerometer gauge 

thumbnail and rotate it to the direction in which connectors on 

the HDX2 system are pointing (i.e. if system is installed with 

connectors facing the front of the vehicle, point the red line at 

12 o’clock). 

• Click the ON/OFF button on the accelerometer gauge so that it 

appears on the video player. 

• Play some captured video and verify that: 

o During braking, the coloured dot on the vertical axis moves up the scale and during acceleration, 

the coloured dot moves down the scale 

o During left‐hand turns, the coloured dot on the horizontal axis moves to the right, and vice‐versa. 

 

How to Zero the Accelerometer on the Accel Gauge 

Even after you have zero-ed the built-in tri-axial accelerometers inside the HDX2 Main System Unit, you may 

need to zero them in Comparo HD so that, when the car is fully stationary, the coloured dot is perfectly central. To 

zero the accelerometer gauge: 

• Navigate to a point in the recording in which the vehicle is stationary and 

on relatively flat ground. 

• Right‐click on the accelerometer gauge in the video player 

• Click Center 
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Course Map 

To enter the Course Map screen in Comparo HD, press the “M” keyboard key. The Course Map provides: 

• Bird’s eye graphical view of the course 

• Graphical indicator of vehicle position on course 

• Corresponding data for vehicle position on course 

• Video thumbnail and playback control 

• Full navigation controls 

 

 

How to Add/Move the Start Line on the Course Map 

Comparo HD assesses GPS data for each track session and automatically assigns a start/finish line position on 

the course map. Comparo HD uses the start/finish line to establish lap number, lap times and split sectors 

(configured by the user). The start line is indicated by a blue line with an arrow, which indicates the direction of 

travel.  

 

If your recordings are from an event where the start and finish lines are located in different places (Autocross, 

Rally, Drag Race, Hill Climb) you will need to define these recordings as such in the “Session Type” section in 

Session Info. For such events, Comparo HD will assess the GPS data and automatically locate the “Launch Event” 

and “Finish Event”, positioning the start and finish lines accordingly. 
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You may want to fine‐tune or change the position of the start/finish line.  There are two ways to do so: 

To move the start/finish line on the course map: 

• Place mouse over the blue line & arrow. You should see this become thicker 

• Left-click to grab the start/finish line 

• Move the start/finish line forwards/backwards on the course map 

• Let go of the mouse button when in the correct location 

The above method may not be highly accurate so an alternative method is to set the start/finish line via the 

video: 

• Review video and/or data trace to identify exact position of start/finish line – stop the video with your 

vehicle right on the start/finish line, using the left and right arrow keyboard keys to move the video 

forwards/backwards one frame at a time. 

• When the vehicle is on top of the start/finish line, select “Configure‐>Put Start Line at Cursor Position” 

NOTE: You will find that, the first time you visit a new track, 

the start/finish line will automatically be placed in the pitlane, 

so your multi-lap outing will appear as a single lap. Use the 

above instructions to position the start/finish line correctly 

and separate your outing into the correct number of laps.  

If you now associate the name of the track (i.e. Silverstone 

GP) with this outing by going to “Configure->Edit Outing #1 

Info” and entering the name in the “Course Name” section, all 

other outings that share the same “Course Name” will now 

share the same start/finish line (and sector split markers – see below). 

 

How to Add/Move Splits to the Course Map 

One method to assess how well you drive on different parts of the track is to split the 

course map into sectors and then evaluate your time and video for each split segment. 

To add a split marker: 

• Place your mouse over a spot on the course map 

• Right-click on the split marker 

• Select “Insert split marker here” 

To move a split marker: 

• Place your mouse over a split marker. You should see this become 

thicker  
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• Left-click to grab the split marker 

• Move the split marker forwards/backwards on the course map 

• Let go of the mouse button when in the correct location 

The Data Graph on both the default combined view and the Data Graph view should now have added split sector 

segments titled S1 (Straight 1), T2 (Turn 2), etc: 

 

  

To view split times and corresponding video and data, expand the Session Info window by pressing the “i” key on 

the keyboard and then press the “Show Splits” button: see the “Session Info” section for more info on this. 

 

 

How to Delete Splits From the Course Map 

There are two ways to delete split markers, individually or all markers at once. 

To delete an individual split marker: 

• Expand the course map by pressing “M” on the keyboard 

• Place your mouse over a split marker 

• Right-click on the split marker 

• Select “Delete split marker” 

To delete all split markers: 

• Select “Configure‐>Delete All Section Markers” 

• Select “Yes” to confirm 
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What the Colours Indicate on the Course Map 

When the course map is expanded by pressing “M” on the keyboard, there is a legend in the bottom‐right corner, 

which indicates the scaling of the colours that appear overlaid on the course map. 

To change the scales of the legend: 

• Return to the default combined view by pressing “X” on the keyboard 

• Place mouse over scale of vertical axis (e.g., speed) on data graph 

• Left-click to raise/lower the dashed lines on the scale to change the values of the 

legend. You should see the course map colours change as you perform this action. 

The default data overlay that is positioned over the course map is “Speed”. To change which data is overlaid, you 

can select from the options that appear on the left of the Course Map window. Selecting Lateral G will provide 

insight into potential oversteer/understeer moments through corners while selecting Inline G will show you 

braking/acceleration points as well as any particularly large bumps. Vertical G can also be used to show this. 

When you have additional OBD-II or ECU/CAN data available, other information such as gear and throttle position 

are very informative when viewed in this way, especially when comparing laps with other drivers. 

 

Data Graph 

The Data Graph page in Comparo HD can be accessed by pressing “G” on the keyboard. This page provides: 

• Color‐coded data traces for valid data channels 

• Selection pane for turning valid data traces on/off 

• Vertical and Horizontal scales, with corresponding values 

• Display based on distance or time 

Z  
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How to Add/Edit Data Traces 

Comparo HD automatically displays a data selection pane and all available data 

sources for each session. 

To add or edit data traces: 

• Review the available data traces in the data selection pane 

• Check box next to data trace(s) to toggle traces on/off 

In the expanded data graph, Comparo HD automatically displays up to three data 

trace windows corresponding to the selected data traces. 

If you right-click on any data label in the data selected pane, you have the ability to 

thicken that data trace, making it easier to see.  

There is also a button in the top right corner of the both Data Graph on the default 

combined view and the Data Graph view that will toggle the Data Graph 

background between WHITE and BLACK. 
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How to Zoom to Examine Data More Closely 

To view data more closely, Comparo HD provides the capability to zoom into the Data Graph on both the default 

combined view or the Data Graph view. 

• To zoom data you can either press “Z” on the keyboard or select “View‐>Zoom Graph” 

 

Session Info 

The Session Info page in Comparo HD can be accessed by pressing “i” on the keyboard. This page provides: 

• Information about the session 

• Number of laps and corresponding lap times 

• Split sector times 

• Fastest lap and split sector times highlighted in green 

• Target lap time calculated from all fastest split sector times 

PLEASE NOTE: In order to view split sector times, you must first create split sector markers on the course map 

and then click the “Show Splits” button. Please see “How to Add/Move Splits to the Course Map” on page 34 for 

more details on how to create split sectors. 

Clicking on any lap or split time will automatically move the video forward/backwards to that position in the 

recording. 
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How to Edit Session Info 

When in the default combined view, session info provides important info about each HDX2 recording such as: 

• Course Name  

• Driver name 

• Car 

• Date & Time 

• Session Type 

• Lap Information 

• HDX2 Firmware Version 

• Video Resolution 

• Frame Rate 

• Start on Speed Information 

• Stop on Speed Information 

• Start on USB/SD Insertion Information 

A lot of this information is created automatically based on 

your HDX2 configuration and recording details but some of 

this will need to be manually inputted by the user. 

To edit session info: 

• Select Configure‐>Edit Session #1 (or 2) info 

• Select desired options from pull‐down menu(s) or Click New to add selection options 

• Click OK when finished 

 

Using Compare Mode 

One of the most effective methods to improve your driving is to compare yourself to against the best, whether 

it’s someone else’s session or a particularly good session, lap or split of your own. Comparo HD gives you the 

power to easily compare laps and sessions on the same course. 

PLEASE NOTE: On less powerful laptops and computers, you may need to use the Picture in Picture controls to 

turn off the Camera 2 image, in order for video to play smoothly.  
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How to Compare One Lap to Another from the same outing 

To compare one lap to another from the same recorded session: 

• Select “Compare‐>Compare Laps” or press “L” on your keyboard. 

Compare mode automatically synchronizes sessions to each other upon opening. To re‐sync at any time you can: 

• Press the Enter/Return key on your keyboard. 

• Double‐click at any point on the data graph. 

• Double-click at any point on the course map. 

• Press the “Sync” button on the screen. 

• Go to “Compare->Sync Sessions” 

 

How to Compare Laps from one outing with those from another outing 

To compare laps from different recordings: 

• Select “Compare‐>Compare Outings”, press “C” on your keyboard or click the “Compare” button. 

Z The “Open” menu pops up with sessions available for comparison (i.e. sessions from the same course) 
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• Click on the session you want to compare 

• Click on Open 

 

When you click on “Open”, the two sessions are automatically displayed side‐by‐side. 
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How Expanded Video Window Changes in Compare Mode 

When in “Compare Mode”, Comparo HD’s video page, accessible by clicking “View->Video” or by pressing “V” on 

the keyboard, displays large screen video. This page will display any enabled gauges. 

 

By double-clicking on a video feed, you will enter “Fullscreen Mode” which will also display any enabled fullscreen 

data overlays alongside any enabled gauges. 
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How Expanded Data Graph Window Changes in Compare Mode 

When in “Compare Mode”, Comparo HD’s Data Graph page, accessible by clicking “View->Graph” or by pressing 

“G” on the keyboard, provides a clear display of the differences in data. 

 

How Expanded Session Info Window Changes in Compare Mode 

When in “Compare Mode”, Comparo HD’s Session Info page, accessible by clicking “View->Info” or by pressing “i” 

on the keyboard, displays all split sector times side by side. 
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How to Re‐sync Sessions in Compare Mode 

“Compare Mode” automatically synchronizes sessions to each other; as sessions 1 and 2 diverge due to different 

driving performance and/or course conditions, the sessions will become out of sync. 

To re‐sync sessions in “Compare Mode”: 

• Double‐click at any point on the data graph. 

• Double-click at any point on the course map. 

• Press the “Sync” button 

• Go to “Compare->Sync Sessions” 

How to Un‐Compare Sessions 

To un‐compare sessions: 

• Click on the “Compare” button and confirm action 

• Click “Compare->Uncompare Outings” 

• Press “U” on the keyboard 

 

Using Export to Create Video Files with Data Overlays 

HDX2 produces video and data files independently, which gives maximum flexibility to configuring gauge overlays 

and exported video files. After your session, you can decide exactly how you want to display data and gauge 

options or modify the layout for different presentation requirements. 

Comparo HD offers a number of ways to edit and export your video and data: 

• HD Export - Export a partial or full session to a single video file for upload 

• Fastest Lap HD Export  - Export the fastest lap from a session to a video for upload 

• Compare HD Export – Export a lap comparison from one/two sessions to a video for upload 

• Upload to YouTube 

• Crop Outing – Crop and save part of a session (e.g., best lap) for continued use within Comparo HD 

• CSV Export – Export the Race-Keeper data only for integration into third party software (i.e. Excel) 

 

HD Export 

To export video: 

• Select “Export‐>Export HD” to open the Export window 

• Modify the camera configuration, video quality, background, gauge and overlay settings accordingly 

PLEASE NOTE: If you wish to use custom backgrounds, save these files to “C:\Program Files\Trivinci\Race-

Keeper Comparo\backgrounds” 
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• Next either left-click drag the “Start” indicator (green arrow labelled Start) to where you want your 

exported video to begin OR play the video by clicking on the “Play” button and when you reach the 

required start point click on the “Start” button 

Note – You can use the keyboard arrow keys to go forwards or backwards by one frame 

• Next either left-click drag the “End” indicator (red arrow labelled End) to where you want your exported 

video to end OR play the video by clicking on the “Play” button and when you reach the required finishing 

point click on the “End” button  

Note - The estimated file size should now appear in the Video Quality dropdown menu and the expected 

length of export in MM:SS should now appear above the Export button 

• Click “Export”, navigate to desired save location, edit the file name, and click on “Save” 

 

Fastest Lap HD Export 

To export your fastest lap, just select “Export->Fastest Lap HD Export” and the software will automatically put 

the “Start” and “End” markers for you, so that the portion selected contains your fastest lap plus an extra bit at 

the start and end of the lap. 

 

Compare HD Export 

If you would like to export a lap comparison video, to highlight how different driving styles & techniques can 

result in a similar/different lap time: 

• Enter into “Compare Mode” by either pressing “C” or “L” and selecting the relevant outing or laps you wish 

to compare. 

• Select “Export‐>Compare HD Export” 

• Modify the camera configuration, video quality, background, gauge and overlay settings accordingly 

• Next either left-click drag the “Start” indicator 

in outing 1 (green arrow labelled Start) to 

where you want your cropped video to begin 

OR play the video by clicking on the left most 

“Play” button and when you reach the required 

start point click on the “Start” button.  
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• Then you would want to select the lap you wish to compare in outing 2 and then press the “Sync” button, 

so that both the  video image and the “Start” indicator in outing 2 is at exactly same point in the lap as 

outing 1. 

• Next, select the point in outing 1 where you wish the video to end and press “End”. The software will 

automatically determine where outing 2 will end without you needing to position an “End” indicator 

• Next either left-click drag the “End” indicator (red arrow labelled End) to where you want your cropped 

video to end OR play the video by clicking on the “Play” button and when you reach the required finishing 

point click on the “End” button  

• Click “Export”, navigate to desired save location, edit the file name, and click on “Save” 

 

Upload to YouTube 

When you have finished exporting a video, we actively encourage you to share it with others via YouTube. As 

such, we have integrated YouTube support into Comparo HD. You can either upload to YouTube from any other 

the export functions previously discussed (Export HD, Export Fastest Lap HD, Export Compare HD) or by selecting 

“Export->Upload to YouTube” and uploading a video you have already exported. 

• Locate the video you wish to upload 

• Give the video a title, description, tags and set whether it should be a public or private video 

• Authorize Race-Keeper Comparo HD access to your YouTube account 

• Upload the video 
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Crop Outing 

To crop a session: 

• Select “Export‐>Crop Outing” 

• Next either left-click drag the “Start” indicator (green arrow labelled Start) to where you want your 

cropped video to begin OR play the video by clicking on the “Play” button and when you reach the required 

start point click on the “Start” button 

Note – You can use the keyboard arrow keys to go forwards or backwards by one frame 

• Next either left-click drag the “End” indicator (red arrow labelled End) to where you want your cropped 

video to end OR play the video by clicking on the “Play” button and when you reach the required finishing 

point click on the “End” button  

• Click Crop, navigate to desired save location, edit the file name, and click on “Save” 

 

CSV Export 

If you wish to use your Race-Keeper data in another piece of software (i.e. Excel or another data-logging suite) 

just click “Export->CSV Export” and two CSV data files will be added to the folder that contains your video and 

data.  

 

Technical Specifications 

HDX2 Video Data Systems 

Video 

• One system for video and data 

• Video format ‐ NTSC 

• Supports two (2) 1080p HD bullet camera inputs 

• Simultaneous dual-stream recording  

• MPEG4 1080p HD resolution (1920x1080 video resolution) 

• Built‐in export software to MPEG4 and other popular video formats 

• User configurable 1080p HD @ 30 FPS or 720p HD @ 60 FPS recording (NTSC) 

• User configurable video bit rate  

• HDMI and Composite live video output ports for camera setup 

Audio 

• Two‐channel input for stereo audio 

• Single locking connector 

• Built‐in Automatic Gain Control for broad range of high and low sounds 
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Data and Data Sources 

• User‐positioned map, gauges and logo overlays 

• Ability to change overlays after video capture 

• High‐res 20Hz GPS for speed, lap #, lap times and track map 

• Three axis on‐board accelerometer (±6.0g range, 0.01g resolution) for Gs 

• Battery voltage, box temperature recorded 

• OBD‐II data via USB 2.0 

• Wi-Fi ready 

• Two (2) CAN I/O ports for ECU interface 

• 1GB Ethernet Port for Video Data Transfer 

Recording Media  

• Records to either removable USB stick or SD card 

• Recording times dependent on video capture settings: 

o Two (2) cameras recording at 1080p 30fps for 1 hour requires approximately 7.0GB 

o Two (2) cameras recording at 720p 60fps for 1 hour requires approximately 6.4GB 

o Two (2) cameras recording at 720p 30fps for 1 hour requires approximately 3.2GB 

o One (1) camera recording at 1080p 30fps for 1 hour requires approximately 3.4GB 

o One (1) camera recording at 720p 60fps for 1 hour requires approximately 3.2GB 

o One (1) camera recording at 720p 30fps for 1 hour requires approximately 1.6GB 

Membrane Panel Control Buttons 

• Power ON/OFF 

• Record START/STOP 

Mechanical and Power 

• Operating temperature: ‐20 to +55 C ambient 

• Storage temperature: ‐20 to +75 C 

• Shock: 0.25m onto hard surface, except connector face 

• Vibration: 6g @ 0‐1KHz random pattern 

• Compliant with FCC part 15 Class B, and current CE standards 

• 12v DC, 1.4A 

• Locking power connector 

Case 

• IP67 waterproof connectors, enclosure and membrane panel 

• High impact retardant ABS enclosure 

• Locking, quick‐release Hirose waterproof connectors 

• Width 7.5" 
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• Depth 5” 

• Height (back) 1.5” 

• Weight 1.0lb 

Installation Options 

• 3M dual lock Velcro 

• 4‐hole AMPS bolt pattern in case standard mount 

• Integrated quick mounting plate 

HDX2 Bullet Cameras 

• Video format: NTSC 

• Image sensor:  

• Scanning system:  

• Total pixels:  

• Electronic shutter:  

• S/N ratio:  

• Video output:  

• Back light comp.:  

• Auto white balance:  

• Gamma correction:  

• Sync mode:  

• Power source:  

• Power consumption:  

• Operating temperature:  

• Storing temperature: 

• Sensitivity:  

• Dimensions (mm):  

• Horizontal resolution:  

• Mounting method:  

• Mounting location:  

• Protection Level: IP67 

 

20Hz GPS 

External GPS antenna has magnetic base for quick attachment to vehicle (can also be mounted using Velcro or 

3M VHB mounting tape). GPS antenna terminated with 5m (15’) cable for connection to HDX2 System. 

20Hz (twenty position measurements per second) electrically‐shielded GPS engine embedded in HDX2 System. 

GPS delivers high‐resolution data used for vehicle speed, track mapping, lap number and timing, outing analysis 

and syncing side‐by‐side outing comparisons. 
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• 20Hz sample rate 

• GPS position accuracy: <2.5 m, horizontal 

• 27dB active antenna 

• Magnetic mount 

• NMEA Input/output: ASCII, 0183, 2.3 (compatible to 3.0) 

• Time to first fix: < 1 sec 

• Acquisition and tracking sensitivity: ‐160dBm 

• Max velocity measurement: 515 m/s (1000 knots) 

• Dimensions: 50.5 mm L x 42 mm W x 13.9 mm H (1.99" x 1.65" x 0.55") 

• Weight: 60 g (without cable) 

• Power consumption: 30 mA (max) 

• Environment: ‐40 to +85 C with high humidity 

 

Trouble-Shooting 

Recording Media 

What size/type of SD card or USB do I require? 

There is no limit to the capacity of SD or USB you can use with HDX2 although the largest capacity SD card we 

have actively tested is a 256GB SDHC card. 

 

Do I need to format my SD/USB in a special way? 

Possibly. If you format your SD/USB as FAT32, recordings will be automatically split into 4GB outings, as this is 

the file size limit defined by FAT32. If you format your SD/USB as NTFS, recordings will be kept as a single outing 

as there is no file size limit with this format. 

PLEASE NOTE: The SD/USB format exFAT is not supported. exFAT formatted media will not be recognized by 

Race-Keeper HDX2 and therefore recording to an SD/USB formatted in exFAT will not be possible. 

 

PC Requirements and Compatibility 

What PC do I need to run Comparo HD? 

Playing two (2) HD video streams, synchronised together with additional data and graphics can work a PC’s 

processor and memory pretty hard. Using “Compare Mode” and having all four (4) HD video streams running 

together will work your PC even harder. As such, you should be aware of the Recommended and Minimum PC 

specifications required to successfully run Comparo HD. 
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Recommended PC Specification: 

• Processor: Intel i7 Processor  

• Memory: 8GB RAM 

• Graphics: 2GB AMD Radeon or NVIDIA GeForce 

• Storage: 1TB hard drive 

• USB: USB3.0 Ports 

• SD: SD Card Port  

Minimum PC Specification: 

• Processor: Intel i5 Processor  

• Memory: 4GB RAM 

• Graphics: Built-In 

• Storage: 250GB hard drive 

• USB: USB2.0 Port 

• SD: SD Card Port 

PLEASE NOTE: If using a machine running at the minimum PC specifications, you will 

have to turn off the picture-in-picture (PiP) view when in compare mode otherwise the 

video playback will not be smooth and may freeze altogether. In order to turn off the 

PiP view, click on button “1” or “2” in the “Picture in Picture Controls”.  

 

What version of Microsoft Windows is Comparo HD compatible with? 

You can use Comparo HD on the following versions of Microsoft Windows: 

• Windows 8.1 (64) 

• Windows 8.1 (32)  

• Windows 8 (64) 

• Windows 8 (32) 

• Windows 7 (64)  

• Windows 7 (32) 

 

PLEASE NOTE: We do not recommend using Comparo HD on Windows XP or Windows Vista as it is likely that 

hardware running such operating systems will not meet the “Minimum PC Specification” listed above. 
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Can I use Comparo HD on a Macintosh or Linux Machine? 

There is no native Apple Mac or Linux version of Comparo HD however you can use a Windows 

emulator to successfully run the software, like Parallels or VMware Fusion. Either of these tools 

will allow you to run the Windows operating system as a normal “windowed” program. From 

there, you can install any normal Windows applications, including our software. If you do install 

VMware or Parallels, be sure to enable 'Hardware Accelerated 3D Graphics' in the settings for the 

virtual machine you create.  

You can also use Apple’s “Bootcamp” to install Windows on a partitioned hard drive. For more 

information on this, please visit this page https://www.apple.com/uk/support/bootcamp/  

We are working on a cross‐platform version of Comparo HD that will work perfectly as a native 

Macintosh application.  

 

Opening and Scanning Outings 

Why can’t I see my outings in Comparo HD?  

If you can’t see your outings in Comparo HD, they probably have not yet been imported into the Comparo HD 

library. In order to successfully import files: 

• Ensure Comparo HD is open before you attach any USB/SD card containing HDX2 sessions. 

When Comparo HD recognises a new media device has been connected, the program will check for and repair any 

damaged files. 

• You may wish to additionally run Windows CHKDSK and check the integrity of the files on the USB/SD 

manually. If the recording media was removed from HDX2 while the system was writing to it, the end of 

the video and data files may not be complete and will need to be repaired. Windows CHKDSK will perform 

this repair. 

 

Why do my outings fail sometimes when I record to USB/SD? 

Not all USB/SD cards are created equal. Some may not have the necessary write speed in order to capture HD 

video. SD cards may also have a slider on the left hand side which looks it meaning you cannot write data to it. 

With USB, it would be worth ensuring that the memory stick is properly inserted and there is no chance it could 

become detached during running.  
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General Comparo HD Questions 

Comparo HD software appears blurry, how can I fix this? 

If you have a HD compatible display on your PC or laptop, you may need to adjust the way Comparo HD appears 

in order for the software to look crisp and clear. To do this: 

• Right-click on the Comparo HD shortcut on your desktop 

• Select “Properties” 

• Select the “Compatibility” tab 

• Check the box labelled “Disable display scaling on high DPI 

settings” 

• Click Apply and then OK. 

When next launched, you should see some visual improvements to 

Comparo HD. 

 

Why does my session appear as only one lap in Comparo HD? 

If the start/finish line is positioned off the main track (i.e. in the 

pitlane), then multiple laps will be displayed as just one long lap. For 

more information read “How to Add/Move the Start Line on the Course 

Map” on page 33. 

 

Does zero‐ing the accel in Comparo HD apply to one outing or to all? 

When you zero the accelerometer in an outing, this offset will be applied to all outings so there is no need to re-

zero each time you load an outing. 

 

Video Player 

Why does my video look choppy? 

Playing HDX2 outings on a computer that does not meet the minimum PC specification can cause the video to 

look very choppy when playing back in Comparo HD. The problem is exacerbated when using “Compare Mode” or 

when very long continuous video files are opened. 

If your computer does meet the minimum PC specification but you are still suffering issues, it could be related to 

the computers power settings, even if your computer is plugged in and charging. 
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To check your laptop power settings: 

• Left-click on the battery icon in the lower right-hand 

corner of Windows 

• Select “More Power Options” 

To check your PC power settings: 

• Open your “Control Panel” 

• Select “Power Options” 

You should now see a screen on which you can select your 

“Power Plan”. You should select the “High Performance” option.  

PLEASE NOTE: The “High Performance” option may be hidden in a section called “Show Additional Plans”. 

Once you have changed the “Power Plan” of your computer to “High Performance” Comparo HD should now play 

smoothly. 

PLEASE NOTE: When running in “High Performance” power mode, the charge in a laptop battery may be 

consumed quickly. 

 

Track Manager 

How do I find the page that shows each lap time and split? 

Access the Session Info page by selecting “View->Info” or by clicking “i” on the keyboard, and then click on “Show 

Splits” at the top of the screen. Laps are displayed down the left of the table. You can click on any of the split 

times and the video thumbnail will jump to that position on that lap. You can play the video from that position by 

hitting the space bar, stop playback by hitting space bar again.  

PLEASE NOTE: You need to create split sector markers in the Course Map before any splits will be visible. For 

more information please visit “How to Add/Move Splits to the Course Map” on page 34. 

 

Is the start/finish line saved with a track? 

Once you have placed the start/finish line and split markers on a track AND provided that track a “Course Name” 

in the “Session Info”, they are saved in Comparo HD. All further outings from that track will use the same 

start/finish and split markers. There is no need to re‐enter them again. 
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Outings List 

If I delete an outing in Comparo HD, will it be deleted from my hard drive? 

YES. Before deleting any files from within Comparo HD you need to be very sure that you no longer need it or 

have made a copy and stored it elsewhere. Once deleted, your video data file will not be recoverable. It will not 

appear in the Windows “Recycle Bin”. 

 

An outing in my library is red and labelled (missing). What do I do? 

If instead of importing HDX2 recordings you just use the “Scan” button and open them from your USB/SD, once 

you remove the USB/SD, it will appear in the library in red text with the term (missing) added to the session 

name. This is because the file is no longer located where it was when Comparo HD last accessed it. 

In order to re-associate the outing either re-attach the USB/SD or move the files to the required location. 

If you wish to remove this entry from the library, press the “Delete” button. Since the file cannot be found, all you 

are doing is deleting the entry from the list, you are not actually removing any files. 

 

 

Cameras and Lenses 

What’s a good way to protect my cameras? 

HDX2’s HD bullet cameras produce the best image quality results when their lens covers are clean and free of 

scratches or dust. Over time, the lens covers on externally mounted cameras can degrade from the constant  
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barrage of grit, dirt and sand. Clean the bullet camera lens cover, before and after every track session. We also 

recommend replacing camera lens cover after every track event to protect lenses and to prolong the life of the 

lens glass. 

The captured video is too light/dark. Can I adjust the light balance? 

HDX2’s HD bullet cameras automatically adjust to the light conditions. 

If you find that the view you are wanting to capture is over-exposed (too light), we would recommend adjusting 

the camera position and/or angle so that the camera is positioned closer to windscreen. Having two (2) cameras 

should allow you to do this, provided there is space and a suitable surface to mount the camera from.  

If you find that the view you are wanting to capture is under-exposed (too dark), adjust the camera position/angle 

so that any sources of bright light are removed.  

 

The image above illustrates an over-exposed view of the track due to the camera being located too far back in the 

cockpit and an under-exposed driver view due to a low winter sun shining through the side window. 
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